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“Latin flavus that means "yellow", consistent with the jaundice caused by yellow fever virus” 

The Viral Most Wanted: The Flavivirus Family 
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Historical aspects 
Yellow fever virus-Flavivirus, was the first human virus discovered.  
In the course of investigating epidemic yellow fever in Havana in 
1900, Walter Reed, James Carroll, and colleagues showed that the 
etiologic agent was a "filterable virus“ and that it was transmitted by 
the mosquito Aedes aegypti. 
 
Loeffler, Frosch, and Koch for their discovery of the first virus of 
animals, foot-and-mouth disease virus, and  
 
Salmon, Smith, Kilborne, and Curtice for their discovery that 
arthropods can transmit infectious disease among animals (the 
agent, Babesia bigemina, the etiologic agent of Texas fever of cattle; 
the vector, the tick Boophilus annulatus). 
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Family: Flaviridae 

Genus: Orthoflavivirus  
Hepacivirus  
Pegivirus  
Pestivirus 
       Bovine V diarrhea virus BVDV-1 & 2,  
       Classical swine fever virus 
       Border disease virus (BDV)  
       Giraffe-virus over HoBi-like viruses to   
       recently discovered  
       Bungowannah virus and atypical  
       porcine pestivirus 

Group IV: ssRNA positive-strand viruses  

The genus Flavivirus is composed of more than 70 recognized arthropod-borne 
viruses (or arboviruses) serologically related and broadly distributed 

https://viralzone.expasy.org/by_protein/24
https://viralzone.expasy.org/by_protein/37
https://viralzone.expasy.org/by_protein/4860
https://viralzone.expasy.org/by_protein/39
https://viralzone.expasy.org/by_protein/294
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Classification Virus Host eographical Distribution 

Mosquito-
borne 
flaviviruses 

Yellow fever virus (YFV) 

Primate populations and 
mosquito vectors (Aedes spp., 
Haemagogus spp., and Sabethes 
spp. 

First discovered in Ghana; mostly in 
tropical Africa and tropical South 
America. 

Dengue virus (DENV) Aedes mosquito and Ae. 
Albopictus mosquito Tropical and subtropical areas. 

Japanese encephalitis 
virus (JEV) 

Vertebrate, Culex 
tritaeniorhynchus mosquitoes 

In northern temperate areas JE occurs in 
summer epidemics, whereas in southern 
tropical areas the disease is endemic and 
occurs year-round.  

West Nile virus (MNV) Mosquitoes, birds, mammals and 
reptiles, human 

First identified in Uganda in 1937, the 
virus is commonly found in Africa, West 
Asia, and the Middle East.  

St Louis encephalitis virus Culex species mosquitoes, wild 
birds, human 

Most cases occur in the eastern and 
central United States during the summer 
and early fall. 

Murray Valley encephalitis 
virus (MVEV)  

waterbirds and Culex annulirostris 
mosquitoes, Aedes normanensis 
mosquitoes, human 

endemic to Australia and New Guinea 

Zika virus (ZIKV) Aedes spp. mosquitoes, non-
human primates, and human  

Isolated in 1947 in the Zika Forest in 
Uganda; Outbreaks did not occur outside 
of Africa until 2007, when it spread to 
the South Pacific. 
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Flaviviridae 
Classification Virus Host geographical Distribution 

Tick-borne 
Flavivirus 

Tick-borne Encephalitis 
virus (TBEV) 

Ticks of the Ixodideae family and 
human 

Endemic to Northern Eurasia and 
commonly seen across Europe. 

Powassan virus (POWV) 
Ixodes scapularis and Ixodes 
cookei ticks, small or medium 
sized mammals, and human 

First reported in 1958 in Powassan, 
Ontario; endemic in the northeast and 
upper mid-west of the United States, 
and cases have also been reported in 
Far-Eastern Russia. the only tick-borne 
flavivirus that is endemic in the western 
hemisphere 

Louping ill virus (LIV) sheep or castor bean tick, Ixodes 
ricinus, human 

Upland areas of the British Isles, 
particularly in Scotland, Cumbria, Wales, 
Devon and Ireland 

Omsk haemorrhagic fever 
virus (OHFV) 

Dermacentor spp. ticks and small 
mammals, human 

in forest-steppe zones of the Omsk, 
Novosibirsk, Kurgan, and Tyumen 
regions of western Siberia 

Kyasanur Forest disease 
virus Haemaphysalis spp. Ticks, human  In the tropical deciduous forests of the 

Karnataka State in South India 
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Virus Properties 
Enveloped, spherical, 
Size: 50 nm in diameter 
 
Genera: Flavivirus, mostly arthropod-borne viruses; Pesti-virus, nonarthropod-borne, 
includes several veterinary pathogens; Hepacivirus, human hepatitis C virus 
 
Genome is a single molecule of linear positive-sense, single-stranded RNA, 10.6-10.9 
(flaviviruses), 12.5 (pestiviruses),or 9.5 (hepaciviruses) kb in size; 5' end capped, but 3' 
end usually is not polyadenylated. 
 
Genomic RNA is infectious 
Cytoplasmic replication; a single polyprotein is translated from genomic RNA; it is cleaved 
cotranslationally to yield nonstructural proteins and three or four structural proteins 
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The enveloped viral particles consist of four structural proteins, namely the core 
protein (C), and envelope glycoproteins E1, E2, and Erns 

Highly virulent CSFV strains such as “Margarita” or “Koslov” 
(the ones that are often used for vaccine testing)  
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The enveloped viral particles consist 
of four structural proteins, namely the 
core protein (C), and envelope 
glycoproteins E1, E2, and Erns 

It codes for 3 structural proteins: 
capsid (C protein),  
membrane (M, which is expressed as 
prM, the precursor to M and  
envelope (E protein) and  
7 nonstructural proteins: NS1, NS2A, 
NS2B, NS3, NS4A, NS4B and NS5 

Maturation occurs on intracytoplasmic 
membranes without evidence of 
budding 
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CSF-Virus replication 

Virus replication takes place in the cytoplasm after 
receptor mediated endocytosis and does normally 
not lead to a cytopathic effect in cell culture 
(naturally occurring CSFV strains were found to be 
non-cytopathic). 
  
A putative receptor is the porcine complement 
regulatory protein cluster of differentiation (CD) 46 
that was shown to play a major role in CSFV 
attachment, together with heparan sulfates.  
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CSF-Virus replication 
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Classical swine fever 
Classical swine fever (CSF), also known as hog cholera, is a 
contagious viral disease of domestic and wild swine. It is 
caused by a virus of the genus Pestivirus of the family 
Flaviviridae, which is closely related to the viruses that cause 
bovine viral diarrhoea in cattle and border disease in sheep.  
 
There is only one serotype of CSF virus (CSFV).  
 
CSF is a disease listed by the World Organisation for Animal 
Health (WOAH) and must be reported to the WOAH. 
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• CSF is 
found in 
Central 
and South 
America, 
Europe, 
and Asia 
and parts 
of Africa.  
 

• North 
America, 
Australia 
and New 
Zealand 
are 
currently 
free of the 
disease.  

Global distribution of classical swine fever virus (CSFV) sub-genotypes (map 
based on Global Administrative Areas (GADM database 2.8; November 2015).  
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Classical Swine Fever 

 
 • The most common method of transmission is through direct contact between 

healthy swine and those infected with CSF virus.  
 

• The virus is shed in saliva, nasal secretions, urine, and feces. Contact with 
contaminated vehicles, pens, feed, or clothing may spread the disease. Animals 
that are chronic carriers of the disease (persistently infected) may show no clinical 
signs of illness but may shed the virus in their feces. Offspring of infected sows can 
become infected in the uterus, and can shed the virus for months. 
 

• CSF virus can survive in pork and processed pork products for months when meat 
is refrigerated and for years when it is frozen. Pigs can become infected by eating 
CSF-infected pork meat or products. 
 

• It has been proven that in parts of Europe, the wild boar population may play a 
role in the epidemiology of the disease. 
 

• The disease has been spread through legal and illegal transport of animals, and by 
feeding swill containing infective tissues to pigs. 
 

Transmission and spread 
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Persistent Infection Vs Latent 
Infection 

Persistent infections are where the viruses are 
continually present in the body.  
 
In a latent viral infection the virus remains in 
equilibrium with the host for long periods of time 
before symptoms again appear, but the actual 
viruses cannot be detected until reactivation of 
the disease occurs. 
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• The disease has acute and chronic forms, and can range from 
severe, with high mortality, to mild or even unapparent. 

• In the acute form of the disease, in all age groups, there is fever, 
huddling of sick animals, loss of appetite, dullness, weakness, 
conjunctivitis, constipation followed by diarrhoea, and an 
unsteady gait.  

• Several days after the onset of clinical signs, the ears, abdomen and 
inner thighs may show a purple discoloration.  

• Animals with acute disease die within 1-2 weeks. Severe cases of 
the disease appear very similar to African swine fever. 

• With low virulence strains, the only expression may be poor 
reproductive performance and the birth of piglets with neurologic 
defects such as congenital tremor. 

 

Incubation period is variable : 5-14 days 

Classical swine fever is a highly contagious, viral disease of swine that in 
its most virulent form causes morbidity and mortality approaching 100% 
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Classical 
Swine Fever 

Fig.  Gross examination of pig affected with classical swine fever. 
(a) Purple discolouration of skin; (b) Epicardial haemorrhages; (c) 
Petechial haemorrhages on kidney 

Pinpoint or petechial 
hemorrhages in the sub 
capsular region of the 
kidneys resembling ‘Turkey 
egg kidney’. 



    www.veterinarymicrobiology.in 

Purple discoloration of skin at the tip of the ears in pigs 
suffered from acute classical swine fever 

Classical Swine Fever 
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Haemorrhagic to fibrinous Enteritis in small and 
large intestine from a fattening pig 
experimentally infected with hog cholera virus: 
small intestine at the right side, parts of ileum, 
caecum, and colon in the middle, and 2 colonic 
samples at the left side. 

Classical Swine Fever 

J. Pohlenz 
https://www.thepigsite.com/publications/2/ileit
is/78/445-classical-swine-fever-csf-hog-cholera 

Button shaped ulcer in the colon of a CSF field 
case 
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CSF related lesions: (a) 
Diphtheroid-necrotizing 
enteritis; (b) 
hemorrhages on the 
epiglottis; 
(c) severe secondary 
infections of the lung 
(Actinobacillus 
pleuropneumoniae); (d) 
necrotic tonsillitis with 
an ulcer; (e) gallbladder 
edema; (f) hemorrhagic 
lymph node; (g) 
necrotizing ileocecal 
valve; and (h) 
splenic infarcts. 
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Immunity to CSF 
Despite the immunopathogenesis of most CSF-related lesions, pigs 
recovering from CSFV infection mount an effective immune response 
with E2-specific antibodies detectable after 10–14 days . The E2 
antibodies are able to neutralize CSFV in vitro and induce protective 
immune responses. These antibodies and protection against re-
infection persist probably livelong. 
 



    www.veterinarymicrobiology.in 

Classical Swine Fever 

 Indian Immunologicals launches classical swine fever vaccine 
Called ‘Raksha Class’, this vaccine has been developed in collaboration 
with Indian Veterinary Research Institute (IVRI), Bareilly 
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Vaccination 

Swine fever vaccine (lapinized swine fever vaccine) 
Dose: 1ml, S/C or I/M 
Primary vaccination: After weaning (weaning at 45 days) 
First booster: 30 days after first vaccination. 
Second booster: After 6 months of first booster. 
Revaccinate at 6 months interval. 
In case of tissue culture vaccine dose and route of administration is same as 
lapinised vaccine but it gives longer duration of immunity 

Lapinized -attenuated by passage through rabbits 
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Classical Swine Fever 

Diagnosis 
• Isolation of Virus: PK-15 cells  
• RT-PCR 
• ELISA 
• VNT 
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Bovine Viral Diarrhoea / Mucosal Disease 
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Bovine viral diarrhea (BVD) is a pestivirus infection 
affecting cattle and some other ruminant species.  
 
Clinical disease associated with BVD virus infection is 
most common in young cattle (6–24 months old). The 
clinical presentation can range from inapparent or 
subclinical infection to acute and severe enteric disease. 
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Mucosal disease (MD) 
Is an uncommon but highly fatal form of BVD occurring in 
persistently infected (PI) cattle and can have an acute or chronic 
presentation. 

Mucosal Disease (MD) is usually sporadic, progressive and 
fatal.  
 
It would seem to occur in a small number of congenitally 
infected animals which are immunotolerant and harbor 
virus in all their tissues without showing any clinical 
symptoms. 
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• Bovine Virus Diarrhea and mucosal disease are clinically 
dissimilar disease syndromes, and were originally described as 
separate diseases. 

• But they are now known to have a common viral etiology. 

Bovine Viral Diarrhoea / Mucosal Disease 
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BVD Etiology 

• Caused by Pestivirus of  Flaviviridae family. 
• Virus is grouped into 2 genotypes, BVDV Type 1 and Type 2, 

based on genomic characteristics and the severity of disease 
they produce in cattle.  

• Each genotype, 1 and 2, are divided into two biotypes- 
cytopathic (cp) and non-cytopathic (ncp) based on how they 
replicate in cell culture.  

• Cytopathogenicity does not correlate with the severity of 
disease in vivo (high and low virulence strains) Some cp 
strains are recovered from animals with mucosal disease 
(MD), but most of the time ncp isolates are recovered from 
infected animals. 
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• The classic virus is ncp; cp isolates are generated by 
mutations or genome rearrangements in the original/parental 
ncp strain.  

• Most (>95%) of the field isolates are ncp. 
• Young calf persistently infected with BVD compared to 

similarly- aged normal herd mate. 
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Epidemiology 

• It is normally an infection of cattle, but it has the ability to 
cause infections in pigs, sheep, goats,, deer, reindeer, bison 
and other wild ruminants. 

•  The virus may be present in various secretions and semen.  
• Spread is by direct and indirect contact.  
• The mode of infection is by ingestion and inhalation.  
• Transplacental infections are frequent and result in serious 

consequences for the embryo/fetus. 
• Bulls may be persistently infected and the virus in semen is 

spread by coitus an artificial insemination. 
• BVD seen predominantly in 6-18 month old cattle as a 

primary infection. 
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Pathogenesis 
  
• Infection is via the oropharyngeal route with primary replication in the 

epithelium of the oropharynx  
• Rapid uptake into the drainage lymph nodes.  
• Viremia involves infection of lymphocytes giving rise to a leucopenia,  
• Spreads to other lymphoid tissues, particularly Peyer's patches. 
• Concurrent replication in the epithelium of the alimentary tract 

results in discrete erosions.  
• which in the oral cavity cause excessive salivation, and in the small and 

large intestine induce diarrhea.  
• Lesions in the nasal cavity and conjunctiva may also occur and be 

associated with discharges. 
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Clinical signs 

• BVDV infection can result in a wide spectrum of clinical 
disease varying from sub-clinical infection to fatal disease.  

• Different clinical signs can be seen simultaneously in a herd.  
• The most common clinical signs are:  

Infertility or abortion – foetal abnormalities  can occur with 
infections later in pregnancy resulting in brain abnormalities.  

•  Calf with cerebellar hypoplasia unable to stand and 
“stargazing”  

• Diarrhoea  
 

 
Incubation period is 9-10 days. 
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BVD 
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• Mucosal disease – a condition 
that can vary in severity from 
mild to severe.  

• Signs include ill-thrift, diarrhoea, 
ulceration in mouth and gastro-
intestinal tract and lameness 
(from ulceration of feet).  

• Death can ensue after a variable 
period of time.  
• Failure to conceive  
• Early embryonic death / 
abortion / congenital deformity  
• Foetal loss  
• Persistently infected calves 
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Mucosal Disease 
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• Diagnosed in laboratories via serology, antigen detection 
assays, virus isolation, and by viral RNA amplification such as 
polymerase chain reaction (PCR).  

• Sample from Buffy coat or nasal swab  immunohistochemistry, 
and antigen-capture ELISA assays.  

• Serological evaluation of acute BVDV infection is most 
commonly performed via serum neutralization in paired sera.  
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Treatment 

•  Currently, there is no treatment available to cure BVD Virus.  
• Antibiotics for Secondary Infections Pneumonia etc.  
• If the animal develops Mucosal Disease, there are treatments 

to alleviate the symptoms, but the animal will eventually die.  
• IV fluids and electrolyte for diarrhea and water loss.  
• PI’s should be euthanized to prevent further contamination 

and potential infection to the rest of the herd. 
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Prevention and control 

• Vaccination does not provide complete protection against 
BVDV infection. 

•  It can help to reduce the number of infections  
• Vaccination is not long lasting. 
•  Regular booster shots should be kept up to date according to 

label  
•  Vaccinated cattle can thus become infected and show some 

symptoms but death will not occur. 
•  Pregnant cattle that are vaccinated have less chance if 

infection and transmission of the virus to the fetus.  
• There is still a chance of abortions in those cattle that are 

vaccinated. 
•   
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Also in the Format Text Effects dialog box, click 3-D Format in the left pane. In the 3-D Format pane, under Bevel, click the button next to Top, and then under Bevel click Circle (first row, first option from the left). 
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On the Home tab, in the Drawing group, click Shapes, and then under Stars and Banners click 4-Point Star (first row, third option from the left). On the slide, drag to draw a star.
On the slide, drag the star onto the top of the first letter (in the example slide, it is “S”) in the text box.
With the star still selected, drag the yellow diamond adjustment handle down to make the points thinner.
On the Home tab, in the bottom right corner in the Drawing group, click the Format Shape dialog box launcher. In the Format Shape dialog box, click Fill in the left pane, select Gradient fill in the Fill pane, and then do the following:
In the Type list, select Radial.
Click the button next to Direction, and then click From Center (third option from the left). 
Under Gradient stops, click Add or Remove until two stops appear in the drop-down list.
Also under Gradient stops, customize the gradient stops that you added as follows:
Select Stop 1 from the list, and then do the following:
In the Stop position box, enter 0%.
Click the button next to Color, and then under Theme Colors click White, Background 1 (first row, first option from the left). 
Select Stop 2 from the list, and then do the following: 
In the Stop position box, enter 100%.
Click the button next to Color, and then under Theme Colors click White, Background 1 (first row, first option from the left). 
In the Transparency box, enter 100%.
Also in the Format Shape dialog box, click Line Color in the left pane, and in the Line Color pane click No line. 
Under Drawing Tools, on the Format tab, in the bottom right corner of the Size group, click the Size and Position dialog box launcher. In the Size and Position dialog box, on the Size tab, under Size and rotation do the following:
In the Height box, enter 0.51”.
In the Width box, enter 0.51”.
In the Rotation box, enter 15°.
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On the slide, select the star.  On the Home tab, in the Clipboard group, click the arrow under Paste, and then click Duplicate. 
On the slide, drag the second star until it slightly overlaps the edge of a letter in the text box.
Change the size of the star in the Drawing Tools, on the Format tab, in the Size group.
Repeat steps 1-3 for a total of five stars.


To reproduce the animation effects on this slide, do the following:
On the Animations tab, in the Animations group, click Custom Animation.
On the slide, select the first star from the left. In the Custom Animation task pane, do the following:
Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Moderate, click Grow & Turn.
Select the animation effect (grow & turn entrance effect for the first star). Under Modify: Grow & Turn, do the following:
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In the Speed list, select Very Fast.
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Click Add Effect, point to Exit, and then click More Effects. In the Add Exit Effect dialog box, under Moderate, click Grow & Turn.
Select the second animation effect (grow & turn exit effect for the first star). Click the arrow to the right of the selected effect, and then click Effect Options. In the Grow & Turn dialog box, on the Timing tab, do the following:
In the Start list, select With Previous.
In the Delay box enter 0.7. 
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On the slide, select the second star from the left. In the Custom Animation task pane, do the following:
Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Moderate, click Grow & Turn.
Select the third animation effect (grow & turn entrance effect for the second star). Click the arrow to the right of the selected effect, and then click Effect Options. In the Grow & Turn dialog box, on the Timing tab, do the following:
In the Start list, select With Previous.
In the Delay box enter 0.2. 
In the Speed list, select 0.5 seconds (Very Fast).
On the slide, select the second star from the left. In the Custom Animation task pane, do the following:
Click Add Effect, point to Exit, and then click More Effects. In the Add Exit Effect dialog box, under Moderate, click Grow & Turn.
Select the fourth animation effect (grow & turn exit effect for the second star). Click the arrow to the right of the selected effect, and then click Effect Options. In the Grow & Turn dialog box, on the Timing tab, do the following:
In the Start list, select With Previous.
In the Delay box enter 0.9. 
In the Speed list, select 0.5 seconds (Very Fast).
On the slide, select the third star from the left. In the Custom Animation task pane, do the following:
Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Moderate, click Grow & Turn.
Select the fifth animation effect (grow & turn entrance effect for the third star). Click the arrow to the right of the selected effect, and then click Effect Options. In the Grow & Turn dialog box, on the Timing tab, do the following:
In the Start list, select With Previous.
In the Delay box enter 0.4. 
In the Speed list, select 0.5 seconds (Very Fast).
On the slide, select the third star from the left. In the Custom Animation task pane, do the following:
Click Add Effect, point to Exit, and then click More Effects. In the Add Exit Effect dialog box, under Moderate, click Grow & Turn.
Select the sixth animation effect (grow & turn exit effect for the third star). Click the arrow to the right of the selected effect, and then click Effect Options. In the Grow & Turn dialog box, on the Timing tab, do the following:
In the Start list, select With Previous.
In the Delay box enter 1.1. 
In the Speed list, select 0.5 seconds (Very Fast).
On the slide, select the fourth star from the left. In the Custom Animation task pane, do the following:
Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Moderate, click Grow & Turn.
Select the seventh animation effect (grow & turn entrance effect for the fourth star). Click the arrow to the right of the selected effect, and then click Effect Options. In the Grow & Turn dialog box, on the Timing tab, do the following:
In the Start list, select With Previous.
In the Delay box enter 0.8. 
In the Speed list, select 0.5 seconds (Very Fast).
On the slide, select the fourth star from the left. In the Custom Animation task pane, do the following:
Click Add Effect, point to Exit, and then click More Effects. In the Add Exit Effect dialog box, under Moderate, click Grow & Turn.
Select the eighth animation effect (grow & turn exit effect for the fourth star). Click the arrow to the right of the selected effect, and then click Effect Options. In the Grow & Turn dialog box, on the Timing tab, do the following:
In the Start list, select With Previous.
In the Delay box enter 1.4. 
In the Speed list, select 0.5 seconds (Very Fast).
On the slide, select the fifth star from the left. In the Custom Animation task pane, do the following:
Click Add Effect, point to Entrance, and then click More Effects. In the Add Entrance Effect dialog box, under Moderate, click Grow & Turn.
Select the ninth animation effect (grow & turn entrance effect for the fifth star). Click the arrow to the right of the selected effect, and then click Effect Options. In the Grow & Turn dialog box, on the Timing tab, do the following:
In the Start list, select With Previous.
In the Delay box enter 0.9. 
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On the slide, select the fifth star from the left. In the Custom Animation task pane, do the following:
Click Add Effect, point to Exit, and then click More Effects. In the Add Exit Effect dialog box, under Moderate, click Grow & Turn.
Select the 10th animation effect (grow & turn exit effect for the fifth star). Click the arrow to the right of the selected effect, and then click Effect Options. In the Grow & Turn dialog box, on the Timing tab, do the following:
In the Start list, select With Previous.
In the Delay box enter 1.5. 
In the Speed list, select 0.5 seconds (Very Fast).
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Click the button next to Direction, and then click From Center (third option from the left). 
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